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What is IVISION?
IVISION™ software provides 
simple, large-scale information
management, analysis and 
distribution for information
providers and their customers.

Build, update and document 
multi-dimensional data tables 
and extracts with the IVISION

BUILDER™. Then provide finger-
tip access to tables and extracts 
via LAN, or deliver them on
diskette or CD-ROM.

Search and explore tables 
with the IVISION BROWSER™.
Then select and subset data,
and quickly browse through 
the information in tables, charts
and maps. Or, use the BROWSER

to create tables from extracts.

Use the IVISION DISTRIBUTOR™

to deliver the BROWSER, along 
with tables and extracts, to 
large audiences inside and 
outside your organization.

This Guide
This Quickstart Guide contains the
i n formation you need to start using
the BROW S E R, g iven data tables or
ex t racts pre p a red with the BU I L D E R.
For more details on using the
BROW S E R see the On-line Help or
the IV I S I O N BROW S E R U s e r ’s Guide.

IVISION Concepts
A d i m e n s i o n describes an attribute
of the table data. Examples of
dimensions are sex, geographical
region and time. IVISION tables
can have up to eight dimensions.
An item is an element of a dimen-
sion. For example, June is an item
of the time dimension, and Male of
the sex dimension. A l a b e l is a title
or display heading for an item. A n
item can have more than one lab e l
although you only see one at a time.

Starting the BROWSER

To start the IVISION BROWSER dou-
ble-click on its icon. IVISION will
open and the Find Table dialog
box will appear. 1

WORKING WITH TABLES
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Finding a Table 
If you’re not already
in the Find Table
dialog box, click
on the Find Table
button in the Tool bar.

Clear all the categories in the 
Find Table dialog box by choosing
the None button; then click on the
category that you would expect to
contain the table yo u ’ re looking fo r.
If you want to see more info r m a t i o n
about what is in a particular tab l e ,
c l i ck on its name in the Tables box
to highlight it; then choose the
Summary button. You can also use
the Search button to search for
t ables containing specific wo rd s
or phra s e s .

Opening a Table
Open an IVISION table by double-
clicking on a table name from the
Find Table dialog box.

Table Browsing
Once you have opened a table,
you can browse through the items
in any dimension. First select the
Active Dimension by clicking on
your choice of dimension tile in
the Dimension bar. You’ll notice
that the dimension is now shown
in the Active Dimension box. Then,
click on the Previous Item button
or the Next Item button to browse
through the data for the items 
in that dimension. Note that each
dimension tile shows the dimension
name and the code or label of 
the item whose data is currently
displayed.

2
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Viewing Notes 
Notes tell you about the data yo u ’ ve
re c e ive d . Table notes explain what’s
in a table; they can be viewed by
selecting Summary from the File
menu.A small dot in the corner of
a dimension or item tile indicates
that there is an associated note.
See dimension n o t e s by ch o o s i n g
Notes from the Dimension menu .
L i kew i s e , see item notes by choos-
ing Notes from the Item menu.

Switching Table Dimensions
Once you have opened a table,
you are in the table view. You 
can change your view of the 
table by dragging and dropping
(one at a time) the dimension
tiles with the mouse. Referring 
to the example on page two, if
you want to see Units across 
Time for the current region,
United States, drag the Units
dimension tile and drop it on the
Region dimension tile. This 
will show the Units dimension
along the rows, with Time 
remaining across the columns.

Nesting Table Dimensions
You can view more than one
dimension at the same time 
along either the rows or the
columns by nesting dimensions.
Nesting means showing one
dimension within another. With
the left mouse button depressed,
slowly drag the desired dimension
tile from the Dimension bar to the
top or bottom edge of the column
labels, or to the right or left edge
of the row lab e l s , until a thick line
(or highlight) appears . Release the
mouse button, and the d ra g g e d
dimension will be nested.

In the example ab ove , the Units
dimension tile is dragged until it
hits the right edge of the row
l abels and the highlight appears .

3
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The left mouse button is re l e a s e d ,
and the Units dimension is nested
inside the Region dimension.
See below.

Selecting Data from a Table
To reduce the amount of displaye d
d a t a , to move data to another
application, or to chart or map
data, you first need to select it.

■ To select a row or a column of
data, click on the correspond-
ing row or column heading.

■ To select multiple consecutive
rows or columns, drag the
mouse across the row or 
column headings.

■ To select disjoint rows and/or
columns, press the CTRL key
while you click on the row
and/or column headings.

With your selection highlighted,
click on the right mouse button
for the shortcut menu. Then select
the desired opera t i o n .You can Hide
the selected items from your cur-
rent view, Show only the selected
items in your current view, or Copy
your selection to the Clipboard to
move it to another application.

Displaying 
Alternate Item Labels

Fre q u e n t ly, t h e re is more than 
one set of labels ava i l able for the
items in a dimension. For ex a m p l e ,
t h e re may be alternate labels in 
a second language. To select the
n ext set of labels for a dimension:

1. Make the dimension active by
clicking on the appropriate
dimension tile.

2. Click on the
Change Labels
button in the
Tool bar.

4
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Searching for Items 
Along a Dimension 

You can reduce the items shown
along a dimension by displaying
only the ones you want. To search
for items along a dimension: 

1. Make the dimension active by
clicking on the appropriate
dimension tile.

2. Click on the
Search Dimen-
sion button in
the Tool bar.

3. In the Search dialog box , c l i ck
on the Data field if you wa n t
to search the data, then enter
m i n i mum and/or maximum 
values to constrain your search .
When you choose OK, IV I S I O N

will search the active items 
and show only those items that
h ave satisfied your criteria.

OR

In the Search dialog box,
click on the field you want to
search. Then enter the text
string that you want to search
for in the Text to Find box.
When you choose OK, IVISION

will search the field you
selected and will show only
those items that contain the
text string you entered.

Note: To jump to a desired 
item along a dimension, choose
Find Next.

Sorting Data 
Across a Dimension

You can sort items across a dimen-
sion to re o rder the way that they
a re displayed in the table view.
To sort items across a dimension:

1. Make the dimension active by
clicking on the appropriate
dimension tile.

2. C l i ck on the
Sort Dimen-
sion button in
the Tool bar.

3. If you want to sort the dimen-
sion based on the data values,
click on the Data field in the
Sort dialog box. Then click on
either Increasing or Decre a s i n g ,
and choose OK.
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OR

If you want to sort the 
dimension based on the 
codes or labels associated 
with a dimension, click on 
the field that you want to 
use to sort, then indicate the
Sort Option and choose OK.

Changing the Frequency 
of the Displayed Data

Many tables have time as a
dimension. You may want to
decrease the display frequency
by aggregating the data. For
example, if your table contains
monthly data, you can choose 
to average or sum the monthly
values to produce annual data.

To change the frequency of 
displayed table data:

1. Choose Time Series from 
the View menu.

2. Click on the desired 
Display Frequency.

3. Click on the Aggregation
Method you want IVISION to
use to compute the new data.

4. Choose OK.

Creating Distributions  
To see numeric values distributed
as a percentage of row, column or
table totals, choose Distributions
from the View menu.If you want
IVISION to compute distributions
for dimensions in addition t o
those on display in the rows and
c o l u m n s , select those add i t i o n a l
dimensions from the Include Dimen-
sions box . When you choose OK,
IV I S I O N will add a new dimension
to the table called Distributions,
which will contain one item for
each type of distribution you
selected.

Charting Data
You can choose from many chart
types to display table data.
To create a chart:

1. Select the rows and/or
columns that you want 
to chart.

2. Click on the
Display Chart
button in the
Tool bar.

6
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3. With the mouse pointer in 
the chart view, click on the
right mouse button to see 
the Charting shortcut menu.

4. Choose Chart Options 
to change the current 
chart type.

5. Make a selection and click
on OK to return to the 
chart view.

ChartBrowsing 
The ChartBrowsing™ feature
lets you create a series of 
charts in rapid succession.
To ChartBrowse™:

1. With the mouse pointer 
in the chart view, click
on one of the headings in 
the title of the chart to make
that dimension active.

2. Use the Previous Item 
and the Next Item buttons 
to chart the previous or 
next item.

Mapping Data
Some tables that have a geo-
graphic dimension have maps
associated with them. To view
the table data on a map:

1. In the table view, move
the cursor to the item 
that contains the data you
want to display on a map.

2. Click on the
Display Map 
button in the
Tool bar.

Zooming In and Out of a Map
To zoom in to a region on a map,
double-click on the region or the
value representing that region.

To zoom out to a higher level 
on a map, double-click on the
white space near the border 
of the map window.

Enlarging Part of a Map
1. While in a map view, move

the mouse cursor to the 
upper left corner of the 
section you wish to enlarge. 7
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2. While holding the SHIFT key
down, drag the cursor to the
lower right corner of the 
section you wish to enlarge.

3. Release the mouse button.

4. To return to the original 
view, use the right mouse 
button to see the shortcut
menu, and click on Restore.

Changing Map Colors
1. With the mouse pointer in 

the map view, click the right
mouse button to see the
Mapping shortcut menu.

2. Choose Map Options.

3. Click on the radio button 
in the Range Definition 
box that corresponds to 
the range definition you 
want on your map.

4. Use the Range Color 
popdown menus to select 
the colors that you want 
to appear on your map.

MapBrowsing
The MapBrowsing™ feature
lets you create a series of 
maps in rapid succession 
for data tables that support 
mapping. To MapBrowse™:

1. With the mouse pointer 
in the map view, click
on one of the headings in 
the title of the map to make
that dimension active.

2. Use the Previous Item 
and the Next Item buttons 
to display the previous 
or next item on the map.

Copying a Chart or Map 
to Another Windows

Application
1. While in the chart or map

view, click on the right 
mouse button to see the 
shortcut menu.
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2. Choose Copy to copy 
the chart or map into 
the Windows Clipboard.

3. Use the ALT + TAB keys 
to make the target 
application active.

4. Choose Paste from the 
Edit menu in the target 
application.

Printing a Table, 
Chart or Map 

To print a table view, a chart 
view, or a map view, click on 
the right mouse button to see 
the shortcut menu and select 
the Print option.

Saving a Table
To save a table, or a subset of 
one, as a new IVISION table,
use the Save As option from the 
File menu. You can also save
IVISION table data in several 
other formats including DBF,
CSV and WKS. When saving 
to any non-IVISION format,
you’ll need to nest all the 
dimensions along the rows or
columns before you save, if 
you want to retain the data 
for all dimensions. (See Nesting
Table Dimensions.)

9



Table Creation Overview
An ex t ract is a special type of
d a t ab a s e file that is created with
the IV I S I O N BU I L D E R. Extracts pro-
vide complete data documentation
and are optimized to permit ra p i d
t able creation with the BROW S E R.
You can create a tab l e by opening
an ex t ract file, defining the dimen-
sions and contents of the table,
and clicking on the Go button.
The next four sections outline
these steps in detail.

Opening an IVISION Extract
To locate and open an IVISION
Extract:
1. Click on the Open File

button in the tool bar.

2. Set the List Files of Type 
box to Extract Files (*.ivx)

3. Set the dire c t o ry to the location
of your Extract and select, or
enter, the name of the Extract.

4. Choose OK.
Extract notes can be viewed by
choosing Extract Summary from
the Data menu.

Defining the 
Dimensions of a New Table 

As soon as yo u ’ ve opened an ex t ra c t
f i l e , the BROW S E R d i s p l ays an empty
t able view and a nu m b e r of source
field tiles to the right. Each source
field tile represents one of the
fields in the original data file.
Source field notes can be v i ewed by
choosing Field Summary from the
Data menu.

Define the dimensions of your
new table by dragging your 
choice of source field tiles, one 
at a time, into the cell area.
First, drag a source field tile 10

CREATING YOUR OWN TABLES
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into the Row Dimension area.
You’ll see that the BROWSER

highlights acceptable areas 
where the tiles can be dropped.
Then, drag a second tile into the
Column Dimension area. Finally,
drag up to six more source field
tiles into the Dimension bar.
Note that where you position 
the source field tiles determines
the default display position for
the dimensions of the new table.
If you make a mistake, you can
drag a tile back to its original
position. Or, you can replace a 
dimension by dragging and 
dropping a new source field tile
onto it.

Filling a Table With Units
If you want the table values to 
be counts, you can create the
table now by clicking on the 
Go button. However, you may
want to have other items aside
from counts in the Units dimen -
sion. Just drag and drop tiles 
associated with numeric values
into the cell area of the table
view. IVISION creates a new
dimension called Units contain-

ing one item for each tile you
move into the cell area. As you
drop the tiles, IVISION lets you
choose which statistical value
related to the source field will be
used to fill the tab l e . For ex a m p l e ,
you can choose sums, averages,
minimums or maximums for
s o u rce fields such as Age or Salary.

Creating a New Table 
Once you’ve defined 
the table, create 
it by clicking on 
the Go button.

Saving a New Table
To save your table for other
BROWSER users:

1. Choose Save As from 
the File menu.

2. Enter up to eight characters
to name the table. When 
you choose OK, the BROW S E R

p ro m p t s you to enter summary
information.

Go
Button

11
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3. Enter the Table Title and
Category which will be 
displayed in the Find Table 
dialog box.

4. If you wish, enter Keywords
and Table Notes to help you
find the table later.

5. Choose the OK button.

Other Table Creation
Features

The Data menu contains options
that you can use to further 
customize your table.

■ The Define Recode option 
lets you create a new source
field tile based on an existing
coded field such as occupation
or marital status. Use this 
feature to combine items 
from an original source field.
For example, for the source
field tile Marital Status, the
codes for Single, Divorced 
and Widowed could be 
combined to form a new
code called Unmarried.

■ The Define Bands option 
lets you create a new source
field tile based on an existing
numeric field.Use this feature
to redefine the default bands
of an existing source field.
For example, if Age is a source
field tile, then you may wish
to change five year bands to
ten year bands.

■ The Derived Field option 
lets you create a new source
field tile using arithmetic
operations on one or more
existing source field tiles.
For example, given Net
Income and Taxes as two
source field tiles, you can 
add them to create a new
tile called Gross Income.

■ The Record Constraint
option lets you create a 
table subject to a constraint.
For example, if Sex is one 
of your source field tiles,
you could create a table that
contains only female data.

See the On-line Help or the BROW S E R

User’s Guide for information on
how to use these options.12
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Need More Information About IVISION?
Call Ivation Datasystems in Ottawa at 

(613) 563-3993.
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■ Browse data tables with 
up to eight dimensions.

■ Work with up to 32,000 items
per dimension.

■ Group data tables by category.
■ Search tables by keyword.
■ Work with several 

tables at once.
■ Switch and nest 

data dimensions.
■ Aggregate time 

series data.
■ Select and hide data.
■ Search and sort data.
■ View data distributions.

■ Chart and map data.
■ ChartBrowse™ and 

MapBrowse™.
■ Zoom in and out of maps.
■ Print tables, charts and maps.
■ Copy tables, charts and 

maps to other Windows 
applications.

■ Save tables in several 
formats including 
DBF, CSV and WKS.

■ Browse dimension notes 
and item notes.

■ Set your language 
preference.

IVISION BROWSER Features Summary
You’ll find the IVISION BROWSER™ very simple to learn and use.

Look at what you can do:

And Now, Create Your Own Data Tables 
From IVISION Extracts.

Suite 502, 265 Carling Avenue, Ottawa, Ontario, Canada  K1S 2E1
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